BibleWorks Workshop

I developed this resource for use with my beginning Greek class (LG1200) at Luther Seminary. Please use or share it as you like. If you are reading this handout on the computer screen, you can click the topic links here and go directly to the item that interests you. –Mary Hinkle Shore (mshore@luthersem.edu)

<table>
<thead>
<tr>
<th>Getting Help</th>
<th>Elements of the Screen</th>
<th>Searching</th>
<th>Copying &amp; Printing</th>
<th>Analyzing</th>
</tr>
</thead>
<tbody>
<tr>
<td>BW help contents</td>
<td>Menu</td>
<td>Find a verse</td>
<td>Copy and paste</td>
<td>p command</td>
</tr>
<tr>
<td>Right click</td>
<td>Button bar</td>
<td>Limit your search</td>
<td>Copy while in Word</td>
<td>Flashcards</td>
</tr>
<tr>
<td>F1 key</td>
<td>Search window</td>
<td>Turn limits off</td>
<td>Copy to BW editor</td>
<td>Bye to M. Henry</td>
</tr>
<tr>
<td>Setup window</td>
<td>Browse window</td>
<td>Search on lemma</td>
<td>Copy formatting</td>
<td>Morphology assistant</td>
</tr>
<tr>
<td>Check for updates</td>
<td>Analysis window</td>
<td>Search one language &amp; display another</td>
<td>BW7: Print search results</td>
<td>Report generator</td>
</tr>
<tr>
<td>Support pages</td>
<td>Controlling analysis window changes</td>
<td>Command line assistant</td>
<td>BW8: Copy menu</td>
<td>Lexicons</td>
</tr>
<tr>
<td>User forums</td>
<td>Command line</td>
<td>Search examples</td>
<td>BW8: Checkboxes</td>
<td>Grammars</td>
</tr>
<tr>
<td></td>
<td>Status bar</td>
<td>Code insertion buttons</td>
<td></td>
<td>Synopsis window</td>
</tr>
</tbody>
</table>

Getting Help

Help within BibleWorks

BibleWorks help contents.
In BW 7, this is called “BibleWorks Online Help”; in BW8 it is “BibleWorks Help Contents.” In neither version do you need to be connected to the internet to use it. This is searchable help file.

Right click.
Everywhere in BibleWorks, if you right-click a mouse, you will get a context-sensitive menu of options. This means your right-click options change depending on where you are and address needs that are related to what you are probably trying to do.

F1 key.
Everywhere in BibleWorks, if you put our mouse pointer over something you’re curious about and press your keyboard’s F1 key, BW help files open at a place the BW editors think might be helpful to you in your present task. If they haven’t guessed right, you can always search for help inside the box that appears.

Setup window.
The wrench is your friend. Click it and access all the setup options. You will see a menu on the left side of the window. Clicking General, then Flags will take you to a variety of options for
customizing BibleWorks. Other left hand menu items will change display versions, copy formatting, etc.

Check for updates.
Automatic checking for updates is your link to patches for the software and new free databases. BW will give you information on each update and not install anything until you give permission. Set automatic checking in the setup window. Click the wrench button, then choose Flags from the left hand side of the window, then click the plus sign beside Internet Updater Options (at the bottom of the main window), and check the box Automatically Check for Updates.

Help from the BibleWorks Site

Support pages.
There are several helpful links on this page, http://www.bibleworks.com/. Look at the navigation across the top of the page. The Support links on the BibleWorks site take you to FAQ pages and other helps.

User forums.
The Forums link takes you to interactive bulletin boards you can read and write to. If you have a question about how to do something, and the Help material inside BibleWorks is not answering it, search in the user forums. Odds are good you'll find an answer just by searching past conversations. If that doesn't turn up what you want, you can post a question in the forum. BW enthusiasts hang out here and love to help others.

Elements of the Screen

Menu.
At the top of the screen. The menu covers most of what you can do in BibleWorks, though sometimes things are “buried” there.

Button bar.
BibleWorks comes with several buttons displayed and some not showing. To add or subtract your button bar, click on the button shown here.

Search window.
This is the window pane on the far left. When you search for words, phrases, etc., your results appear in this window.

Browse window.
In the center of the screen, this window contains the whole Bible when it is in browse mode, so clicking and dragging the scroll bar on the right is not advisable. Arrows at the top of the scroll bar move you one verse at a time through the text.

Click the browse window options button to set up which versions to display and how to order them.
Click the footprints button to toggle between browse mode and seeing a verse or group of verses in several different versions at once.

Analysis window.
Here are tabs upon tabs for different views. Access various resources within BibleWorks as they relate to the specific passage you are reading. The editor and notes tabs are also here.

Controlling analysis window changes.
To stop the resources or analysis windows from skipping to new information every time you mouse over a new word, hold down the Shift key. To change the setting for good, right-click inside the resources window and choose “update only when shift key depressed.” If you choose this option, you will need to hold down the Shift key to change the information rather than to hold the window’s content.

Command line.
Use this line to request Bible passages, word searches, and other things from BibleWorks.

Status bar.
This is at the bottom of the BibleWorks page. The grey words are actually links to dialog boxes for changing the configuration of BW. Double click words in the status bar to set search limits, toggle the Browse and Analysis windows on and off, etc.

Searching

Find a verse.
Type the verse or verse range you want in the BibleWorks Command Line. You may use either the three-letter book abbreviations from BW, or other standard ways of abbreviating books. (You can set additional abbreviations for BW to recognize by clicking on the wrench button, then choosing Book Names from the left hand menu and following the instructions there.)

Examples
Joh1:1 or John 1:1 moves the browse window to the first chapter and verse of the gospel of John.

John 1:1-5 loads the first five verses of John's gospel into the browse window.

Limit a search.
Double-click the word "Limits" at the bottom of the BW page to open the Options dialog in the Search Limits window. You may limit a search in three ways:

Limit a search to particular book(s).
You can limit a search to a particular book or books of the Bible by choosing the book(s). You may want to clear all checkmarks before you click on the book(s) you want.
Limit a search using BW predefined search ranges.
Several custom search ranges are built into BW. You can search just the gospels (which, oddly, in the BW predefined ranges also includes Acts), or just the Pentateuch, etc. Click one of these and then click OK.

Limit a search to your own custom search range.
Building and searching your own custom search range is a two-step process.

1. Add a New Predefined Range. Fill in the information you want here. Give your range a name; choose a version to search (I think this choice is overridden by the version chosen in the main search window), and define your range. It can be anything from a verse to the whole Bible. Click Save.
2. Choose your new range in the list of Predefined Ranges, and click OK.

Turn limits off.
Double-click Limits in the status bar and choose the radio button at the top of the window labeled, Do not apply any limits to this search.

Search on lemma in Greek or Hebrew.
Mouse over any Greek or Hebrew word in the Browse Window (center pane), right click, and you will have the option to Search on Lemma. If you choose this option, BW will perform a search for the dictionary form of the word you are hovering over. This means you will get all the forms of that word, not just the word with one particular spelling.

Search Greek or Hebrew & display English.
The way to switch search results to a different version is different in BW7 and BW8.

BibleWorks 7: Reading Greek or Hebrew search results in English
When you search on a Greek or Hebrew word, results of your search appear in the Search Window in Greek or Hebrew. If you would prefer to read your results in English, just type an English version three-letter identifier in the Command Line (that is, type NRS for example) and click Enter (Return) on your keyboard. The results of your search stay the same, but the verses are now displayed in the version you just requested.

BibleWorks 8: Reading Greek or Hebrew search results in English
Getting from a Greek or Hebrew search to an English results list is a two-step process in BW8.

1. In BibleWorks 8, typing a new version code in the Command Line and you have changed your search version, but not your display version. The search version is now shown in beside the display version just below the Command Line like this: NRS/BNT, and the results are still in Greek.
2. To see Greek or Hebrew search results in English, click the arrow beside BNT (it doesn’t work just to hover over the arrow) and choose Synchronize Results List. The results of your search stay the same, but the verses are now displayed in the search version you chose.
**Command line assistant.**

If you want help setting up searches, the Command Line Assistant might be what you’re looking for. Click the Button Bar setup button (see Button Bar setup above). In the dialog there, find the Command Line Assistant button, and add it to your button bar. Clicking on it will bring up a help window for building searches.

**Search Examples**

These tables are part of the Bibleworks help file. You can see search examples in BibleWorks 8 by clicking on the down arrow next to the little Tools drop down menu under the Command Line.

**English searches.**

<table>
<thead>
<tr>
<th>Ver</th>
<th>Command Line</th>
<th>Finds all verses with . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>KJV</td>
<td>.jesus</td>
<td>containing the word Jesus</td>
</tr>
<tr>
<td>KJV</td>
<td>.jesus christ</td>
<td>containing both “jesus” AND “christ” anywhere in the verse in any order</td>
</tr>
<tr>
<td>KJV</td>
<td>/jesus christ</td>
<td>containing either “jesus” OR “christ”</td>
</tr>
<tr>
<td>KJV</td>
<td>.jesus !christ</td>
<td>the word “jesus” but NOT the word “christ”</td>
</tr>
<tr>
<td>KJV</td>
<td>‘jesus christ</td>
<td>the phrase “jesus christ”</td>
</tr>
<tr>
<td>KJV</td>
<td>‘christ jesus</td>
<td>the phrase “christ jesus”</td>
</tr>
<tr>
<td>KJV</td>
<td>.paul</td>
<td>the word “paul”</td>
</tr>
<tr>
<td>KJV</td>
<td>.paul barnabas</td>
<td>“paul” AND “barnabas”</td>
</tr>
<tr>
<td>KJV</td>
<td>/paul barnabas</td>
<td>either “paul” OR “barnabas”</td>
</tr>
<tr>
<td>KJV</td>
<td>.paul barnabas;5</td>
<td>“paul” AND “barnabas” within 5 verses of each other</td>
</tr>
<tr>
<td>KJV</td>
<td>.paul !barnabas</td>
<td>the word “paul” but NOT the word “barnabas”</td>
</tr>
<tr>
<td>KJV</td>
<td>.paul !barnabas;5</td>
<td>the word “paul” but NOT the word “barnabas” within 5 verses</td>
</tr>
<tr>
<td>KJV</td>
<td>(/paul saul).(barnabas)</td>
<td>either “paul” OR “saul” AND barnabas in the same verse</td>
</tr>
<tr>
<td>KJV</td>
<td>(/paul saul).5(barnabas)</td>
<td>either “paul” OR “saul” AND barnabas within 5 verses</td>
</tr>
<tr>
<td>KJV</td>
<td>(/Martha Mary).!(.Martha Mary)</td>
<td>either Mary OR Martha but NOT both (an exclusive OR search)</td>
</tr>
<tr>
<td>KJV</td>
<td>(christ).!('the christ').!('jesus')</td>
<td>Christ but neither “the Christ” nor Jesus</td>
</tr>
<tr>
<td>KJV</td>
<td>(.paul barnabas;2)/(.paul silas;3)</td>
<td>“paul” AND “barnabas” within 2 verses OR “paul” AND “silas” within 3 verses.</td>
</tr>
<tr>
<td>KJV</td>
<td><strong>dom of god</strong></td>
<td>phrases like “wisdom of god”, “kingdom of god”, and so on</td>
</tr>
</tbody>
</table>
Greek searches.

<table>
<thead>
<tr>
<th>BNT</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;πιστ&quot;</td>
<td></td>
<td>words containing the substring &quot;πιστ&quot; (138 forms found)</td>
</tr>
<tr>
<td>πίστος ο λόγος</td>
<td></td>
<td>words πίστος ο λόγος (&quot;faithful saying&quot;)</td>
</tr>
<tr>
<td>πευλός βαρναβάς</td>
<td></td>
<td>the words πευλός AND βαρναβάς (nominative forms only)</td>
</tr>
<tr>
<td>πευλ* βαρναβ*</td>
<td></td>
<td>words of the form πευλ... AND βαρναβ...</td>
</tr>
<tr>
<td>πευλ* βαρναβ*:5</td>
<td></td>
<td>words of the form πευλ... AND βαρναβάς... within 5 verses</td>
</tr>
<tr>
<td>χριστ* ιησ</td>
<td></td>
<td>words of the form χριστ* AND words of the form ιησ*</td>
</tr>
<tr>
<td>χριστ* ιησ*</td>
<td></td>
<td>words of the form χριστ* but NOT words of the form ιησ*</td>
</tr>
<tr>
<td>ουκ * οιδε</td>
<td></td>
<td>the words ουκ and οιδε with any two intervening words between</td>
</tr>
<tr>
<td>ουκ *99 οιδε</td>
<td></td>
<td>the words ουκ and οιδε with any 99 or fewer words intervening</td>
</tr>
</tbody>
</table>

**Code insertion buttons.**

BibleWorks performs searches at many different levels of complexity. All of these searches are built with keystrokes that look like computer code. Instead of memorizing all these keystrokes, I display code insertion buttons. Inside the Command Line, right click. Choose Code Insertion Buttons from the menu. A row of buttons appears under the Command Line. As you hover the mouse over each one, you see a tip for what the kind of search each one will facilitate.

**Copying & Printing**

**Copy and paste.**
You can highlight, copy (ctrl + c) and paste (ctrl + v) text from the Browse Window (center window) to a Word document. This is a quick way to get a block of BW text into a Word document.

**Copying directly into Microsoft Word.**
When you have both BibleWorks and Word open, you can get paste from BibleWorks without leaving Word. Use keyboard shortcut ctrl + shift + B. A popup window will appear ready to copy the current search version into you document. Position your cursor in Word where you want the verse(s). Type a verse or verse range into the popup window, click Copy, and your selection will appear.

**Copying directly into the BW editor or notes area.**
BibleWorks has its own word processor. In the Analysis window you will see a tab for editor and/or notes (BW7 and BW8 are slightly different visually here). To copy a text into the editor or notes area, highlight the text, hold down the left mouse button and drag the text into the editor or notes area. This
may be helpful if you want to write notes or prepare a paper while continuing to work with other tools in BW.

**Copy format options.**

BW7 has a Copy Center item in the Tools menu. Open Tools/Copy Center. BW8 gives access to these options and others from the Copy menu just under the Command Line.

*Interleave*

When you are copying a range of verses, such as a pericope, you can choose the versions you want to copy, then click Format Options. All sorts of options open up to you. Interleave Versions creates a line-by-line interlinear text of the versions chosen.

*Colors*

You have to choose "colors" if you want highlighting or font coloring to travel from BW to Word.

**BibleWorks 7: Print verses from search results.**

To print verses (and not just a list of citations) from the Verse List Window, choose Copy Center from the Tools menu. Choose Text of Verses in Verse List. Type in the versions you want to copy. If you want the word you searched to be highlighted in your Word document, click on Format Options in the Copy Center dialog; then, inside Format Options, in the Include area, choose Colors. Copy results to a Word document. From there, you can save, move, or print your results.

**BibleWorks 8: Help with copying.**

Everything you need is in the Copy drop-down menu under the Command line. Choose material to copy, then a destination for it. To change the look of what you get, choose Configure Copy Favorites for a task.

**BibleWorks 8: Those checkboxes in the search results area.**

BW 8 allows you to refine your results before copying or printing them. Right-click in the search results and choose Checkbox options from the context menu.

**Analyzing**

**p (for parallel) command.**

In the command line, type `p nrs bnt niv`, press return, and up pops a new window with the NRSV, BibleWorks NT (NA27), and NIV in parallel windows. You can line up as many versions as you like this way. You cannot print from this window since it is functionally the whole Bible in as many versions as you have lined up.

**Vocabulary flashcard module.**

You can set the flashcard module to quiz you on words in a certain pericope, or on words that occur more than 50 times in the NT, and so on. The module includes a pronunciation file for each word. To explore it:
Click on Tools in the menu at the top of the BW window, then Vocabulary Flashcard Module.

Click on Tools in the menu at the top of the BW window, then Language Tools, then Vocabulary Flashcard Module.

The module comes with a few different databases.

- Choose File/Open... from the menu of the flashcard module to explore your options for groups or words to study.
- Choose Tools/Filter... from the menu of the flashcard module to bring up a window where you can choose to limit the words you study by (a) chapter of a grammar textbook, (b) frequency in the Bible, or (c) appearance in a particular portion of Scripture.

Turning off Matthew Henry
You will so get busted if you attempt to use Matthew Henry as a source for a seminary paper. To make the Matthew Henry commentary disappear, take these steps:

In the Analysis window pane, choose the Resource Summary Window, then choose Resource Summary tab, then References tab, then remove the checkmark from Matthew Henry Commentary.

In the Analysis window pane, choose References, then remove the checkmark from Matthew Henry Commentary.

Morphology assistant.
This tool allows you to search a particular pericope, book, or the whole Bible for all occurrences of a particular part of speech. It is helpful when you are learning a language and want to identify all indicative verbs, for instance, or identify all uses of the genitive in a text.

Click the Button Bar Setup button. (Selecting the button is the only way I can figure out to access this tool.)

Choose Morphology Assistant from the available buttons. It looks like the Greek letter alpha. Click Add. Click Close. The Morphology Assistant button is now on the far right of your top button bar. You may have to click on the far right side of the button bar to see it.

Before opening the Morphology Assistant, first limit your search to the excerpt of the Bible you want to search. (See Limit a search to your own custom range, above.) When you have set the limits you want, open the Morphology Assistant. From the Version drop-down box, choose the morphologically tagged Bible version you want to search. Identify what you want to search for. Click Lookup. You have just executed a search. Your results will appear in the Search window pane in the main BW window.
Report generator.
From the Tools menu, choose Report Generator (BW7) or Importing/Exporting Information, then Report Generator (BW8). Choose the range of verses you want a report on. Choose what kind of information you want included. For instance, you could include the lexicon entries (either a minimal entry, like that in the UBS lexicon, or a substantial entry like that from Thayer) for every word in your range of verses. You can include morphological information. The final report will have (a) the text in all the versions you chose, (b) each word in the text parsed, if you chose morphological information to be included, and (c) lexical and other information you checked. After you make your choices, and click Build Report, a new window appears. You can manipulate text in this window, save it, print it, etc.

Word analysis tab (BW7) or Analysis tab (BW8)
The far right pane of BW is the place to access secondary sources on the Biblical text. If the Analysis tab is on top, you can see lexical information for any Greek or Hebrew word you mouse over in the Browse window. The Word Analysis tab will display the translation notes of any English translation. The NET Bible, with its 60,000 translator notes, is particularly helpful for figuring out curious translation issues.

To stop information in this window from changing when you mouse over a new word, hold down the Shift key. (See Controlling Analysis Window Changes above.)

This resource comes bundled in BibleWorks 7 and is an add-in to purchase with BibleWorks 8 (go figure). Find Metzger by clicking on Text Criticism from the Resources menu.

Lexicons
BDAG and HALOT are Greek and Hebrew lexicons available for purchase either separately or together. These are the best resources of their kind, but also pricey. In the Resources menu, you will find the other lexicons already bundled in BibleWorks in the Resources menu. As you start typing in the box at the top of the lexicon window, the word list at the left changes to help you find the word you are looking for.

- You can also access lexicon for any word by right-clicking in the browse window and choosing, “Look up lemma in lexicon browser.”
- To choose the lexicon that appears in the Resources (or Analysis) window, right-click in that window and choose “default analysis Greek (or Hebrew) lexicon.”

Grammars
BibleWorks 8 now comes with Wallace, Greek Grammar Beyond the Basics: Exegetical Syntax of the New Testament. The table of contents in this and all the others grammars is hot-linked. You can click on the word, “adjective,” and go directly to the discussion of adjectives. When you get to the discussion you want to read, all the examples are hot-linked back to the Bible. Find the Grammars in the Resources menu.

Synopsis window
From the tools menu, choose Synopsis Window (BW7), or Tools, then Viewing the Text, then Synopsis Window (BW8). A new window with each gospel parallel in a separate pane.
• To change what version is displayed, choose Edit from the File menu, typing over "NAS" with another version, choosing Save from the File menu, then closing the window and re-opening it.

In this new window, click the File menu, then Open. You'll see various options for comparing texts. Two particularly helpful options are here:

*Aland (greek)*
This opens the gospels parallels in Greek.

*otnt*
This opens two panes: on one side is a New Testament text. On the other is an Old Testament text that the editors think you will benefit from reading alongside the NT text.

• To see the Greek New Testament and the Septuagint side by side, choose File, then Edit in the synopsis window. From there, add BGT as one of your display texts. (BGT is the combined LXX and Greek NT). Close the window. When you reopen the otnt file, choose BGT from the Display menu. You’ll see Greek OT and NT texts side by side.